Visual COBOL for Visual Studio Getting Started with Solutions, Projects and the

1)

COBOL CALL Statement

Overview

1.

Solutions and Projects

In Visual COBOL for Visual Studio, the main unit of work is called a solution. Solutions can contain multiple
projects. These projects can be managed code COBOL projects or native code COBOL projects or can be
C# projects or VB.NET projects, etc. Visual COBOL projects can contain only COBOL programs or classes
but these programs and classes can interact with the programs or classes contained within projects
written in a different language like C#.

There are two basic types of projects, Application projects and Library projects. Normally, a solution
would contain a main Application project like a Windows Forms Application, WPF Application or a Console
Application. Application projects generate an output file with the .EXE extension and contain the main
entry point of an application. Library projects, like a Class Library or a Link Library typically contain
programs and classes that are called by the main application project. Library projects generate an output
file with the .DLL extension.

Each project can contain one or more source programs or class programs. In managed code, each project
is compiled into a single output file called an assembly. In native code COBOL Application and Library
projects you can also select to have multiple output files. In this case, each individual program within the
project will be compiled into its own .EXE or .DLL.

Problems with Calling Programs Located in Different Projects

Each project specifies an output folder into which its generated output files will be stored. The default
name of this folder varies depending on the project CPU settings and which build type you are using such
as DEBUG or RELEASE. The default location is in a subfolder which is relative to the projects main folder,
i.e., .\bin\x86\debug. This default name of the output folder is configurable under the COBOL tab of the
Project Properties page.

There are two issues that need to be addressed when a program in one project calls a program in another
project.

1. Programs that are called cannot be found.

When an application is started in Visual Studio the output folder in which the main application resides will
become the current folder. Programs that are called must either be placed in this startup folder or all
programs must be placed in a different folder or they must reside in a folder that is locatable via
environment variable PATH.

2. Entry points that are called that are different from the name of the .DLL cannot be found.

When the name of the program in the call statement matches the name of the .DLL on disk then it will be
found as long as the conditions in 1 above are true. But if calling an entry point which is the name of
another program within the .DLL or the name of an entry point specified in an ENTRY statement within a
program in the .DLL, the .DLL containing the program to be called must be preloaded in order to make its
entry points visible to the run-time system. This can be done using one of the following methods.

- set proc-pointer to entry “dliname”

- Micro Focus Entry Name Mapper (MFENTMAP)

- Interop Preload section of app.config file (managed code only)

All of these scenarios will be covered in the tutorials that follow.
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Working with .INT/.GNT/.LBR Projects

In this tutorial you will be shown how to setup and use a Visual COBOL solution which uses Micro Focus
proprietary executable format files, known as .int, .gnt and .lbr. A .int file contains intermediate code
generated by the compiler that needs to be run through an interpreter in order to run. A .gnt file is produced
by the native code generator which converts .int code into a faster format which is native to a specific
processor. Both .int and .gnt files contain the code generated from a single COBOL source program. When run
they must be started by a trigger program such as a native .EXE or one of the provided triggers like RUN.EXE or
RUNW.EXE. When running or debugging these programs in Visual COBOL, they can be run without a user
supplied trigger.

An .lbr file is a container like a .dll that can hold one or more .int or .gnt files and can be loaded by your
application. .Ibr files will not be covered in this tutorial.

Start Visual COBOL and from the main menu select New—>Project as shown below:

o g i T S Y

File | Edit View Debug Team Data Tools Test Window Help

New » | 5] Project. CtrisShiftsN | |
Open * | @ WebSite.. Shift+Alt=N |5
Close Lig Team Project...
Close Solution ] File.. Ctri+N

7 Sav ected ems Ctrl+5 Project From Existing Code...

F
On the New Project Dialog select Native under COBOL, highlight Micro Focus IntGnt Project and then change
the Project Name and Location to intgntmain and C:\intgntmain respectively. Also uncheck the option for
Create Directory for Solution so that your project will have the same folder structure as shown in this tutorial.
lick OK to create the new project.

New Project ' ) M}

Recent Templates I.NET Framework 4 v I Sort by: lD&fault v ] ‘ Search Instalted Tem R ]
Installed Templates

CEL | Windows Application COBOL Ayviec: COBOE
4 COBOL = A project for creating Micro Focus INT or
Database Bl coicnni GNT code
Managed = pplication COBOL
Native
Web
Visual Basic
Visual C& CBL | Link Library COBOL
Visual C++

Visual F2 w28 Micro Focus INT/GNT COBOL
Database

i ‘ Micro Focus INT/GNT
Test Projects

Other Project Types

Online Templates

Empty Project COBOL

(2]
#]

£
ey

Name: intgntmain

Location: c:\intgntmain v | Browse... l

|| Solution name: intgntmain || Create directory for solution

[l || Add to source control

ﬂ )
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Visual COBOL will automatically create a solution with the same name as your project file. If you do not see

the Solution Explorer Window or the Properties Window you can select to display them under the View menu
item.

To add a new program to this project, right click on the project name in Solution Explorer and select
Add—>New Item.

J
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Highlight COBOL Program from the list and then click the Add button at the button to accept the default name
of Program1.cbl.

Add New Item - intgntmain . as M
Installed Templates Sort by: [Default v ] Search Installed Templates pe) |
4 COBOL Items

S Type: COBOLIt
Nitive Cj| COBOL Program COBOL Items G i
A new COBOL program file
line Templ =

Suiine Templses | Copybook COBOL Items
‘E =| Application Configuration File COBOL Items
= L
=.2] Resource File COBOL Items |

Name: Programl.cbl

pe

Modify the source code to Program1.cbl in the editor so that it looks exactly like the image below:

identification division.

_g Selution 'intgntrmain’ (1
program-id. Programl.

4 @ intgntmain
=d| Properties

>l

environment division. 3 References
configuration secticon. | Programl.chl
data division.

working-storage section.

@1 myparams pic x(28) wvalue "from progl”.
procedure divisicon.

call "program2” using rrypar‘arrs-l
goback.

% Team...

end program Programl.

Properties
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Now we will add a second program to our project. Right click on the Project name in Solution Explorer, which
is the intgntmain in bold with the CBL icon next to it and select Add->New Item.

[Code)® x Solution Laplorer * U X
|V precethute ivision . = ﬂ
identiflcotion division 1 3 Soluton inkgntmmn O project)
prograe- id " | .
- Bwld fopertien
environsent division !
Pty Heivnce:
configuration section
Cleng r-gum) ol
data divisi g
Y v Ay Pl Ney e Chele Shifte A
working -storage section -
01 myparae piec x(29) value “froe progi” Adil Jervce Reference | Ewating e Shift«Alte A
procedure division, Add Lettirsg COBOL Netrn 3 Nw Folder

Highlight COBOL Program from the list and then click the Add button at the button to accept the default name
of Program?2.cbl.

Add New Item - mtgntmam? v E i‘ w

Installed Templates Sort by: lDefault ] HE ‘ Search Installed Templates pel |
4 COBOL ltems
N Type: COBOL
' [Native) rj|  CoBOL Program COBOL Itemns YEe ome

A new COBOL program file
Online Templates

= COBOL Program
= Cop COBOL ltems

Application Configuration... COBOL Items

Resource File COBOL Items

Program2.cbl

Edit Program2.cbl so that it looks like below. Make sure that you change the program-id from Program2 to
Prog2 and then delete the end program statement at the bottom.

LDl Programl.chl [Code]® ~ Solution Explorer
vl W procedure division - | e
identification divisien. + ; Selution 'intgntrmain’ (1 ¢
program-id. Prog2. - ‘Eﬂ intgntmain

=d| Properties
«g] References
[@ Programil.chl
@ Program2.cbl

environment division.
configuration section.

data division.

working-storage section.

linkage section.

@1 myparams pic x(28).

procedure division using myparams.
move “from prog2" to myparams
goback.

=

% Team...

Properties
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Press the F11 key to build the project and start debugging. Since each .int file in the project can be run as a
standalone program you will be presented with a dialog box where you can choose the program to run. Select

ol
Organize v New folder By @ l
- » £ T
S Favorites P Name Date modified Type S
B Desktop \i Programl.int 9/5/201210:16 AM  COBOL Intermedi...
& Downloads = Program2.int 9/5/201210:16 AM  COBOL Intermedi..,
i+ Dropbox £
| Recent Places
4 Libraries |
|5l Documents
J‘ Music
|| Pictures
Videos
N m | ’
File name: Programl.int v [Micro Focus executable (*.gnt;* v]
[ Open ]v] [ Cancel ]
— =)

The current statement should be highlighted as shown below. Press the F11 key again to execute the current

line.
Program2.chl [Code] Programl.chl [Code] 3 _
% Programl vl W procedure division
identification division.
= program-id. Programl.

environment division.
configuration section.

data division.

El working-storage section.
l @1 myparams pic x(28} value "from progl”.
El procedure division.
= call "program2” using myparams
goback.

end program Programl.

100 % - +
Autos -
| Mame Value Type
¥ myparams from progl PIC X[

Control should now be given to the called program, Program2 as shown below: Continue to press F11 to step
through the rest of the statements and return control to Program1. Press F11 on the goback statement in
Program1 to exit the debugger.
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(o1 e Programl.chl [Code]

'l W procedure

identification division.
program-id. Prog2.

envirenment division.
configuration section.

data divisicn.

working-storage section.

linkage section.

@1 myparams pic x(28).

procedure division using myparams.
fpove "from prog2” to myparams
goback.

Notice that the call statement was referencing program2 which is the name of the program on disk and not
the name of the program in the program-id. Now change the name in the call statement from program2 to
prog2 as show below and then press F11 to start debugging again.

I P oo Cocel < [

vl % procedure division

identification division.
program-id. Programl.

envirenment division.
configuration section.

data division.
working-storage section.
@1 myparams pic x(2@) value "from progl”.

procedure division.

all "progz” using myparams
goback.

end program Programl.

Press F11 to step through the call statement. You should see the following error:

-
Microsoft Visual Studio

173  Called program file not found in drive/directory: prog2 -

Al

yntinue Ignore

Iy

_— S A,
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This is because in an .int/.gnt project all source programs are not automatically packaged together into a
common container like they are for a native project like .EXE or .DLL. Two separate files are generated in the
project output folder, Program1l.int and Program2.int. This means that you must preload an .int file if you wish
to call an entry point in it that is not the same as the program name on disk.

Click Break and then select Stop Debugging from the Debug menu:
Detigang) - Moo Vaus 2do - —

 Pomect Bl Deto; Tesm Dets Tock Tet Wedes Mol
- J ‘ F I | “ - T
s & SRl ertome .
121 Programd
4 Stug Debuqgory e %
Progrem .
- . Letach A
- - v
ot
. " o Rl ¥
Ata .
s mpec .
3 Seple 2
- B Bep Ove 4
o 3 9 —
v - QoW Sde. £3
call “preg2 Togpe besrgeert

gobach Yorws b taagomt .

There are a couple of methods that can be used to preload a .int or .gnt whose main entry point has not yet
been called.

First is by setting a procedure-pointer variable to the entry of the .int/.gnt name.

Add a variable called pp to the working-storage section of program1.cbl and then add the set statement as
shown below before the existing call statement.

identification division.
program-id. Programl.

envircnment division.
configuration section.

data divisicn.

working-storage section.

@1 myparams pic x(28) value "from progl”.
@1 pp procedure-pointer.

procedure division.

set pp to entry “program2"
call "prog2™ using myparams

goback.

end program Programl.

The set statement will preload “program2.int” and make any entry points in it visible to the COBOL run-time
system. Press F11 to start debugging and step through the call statement to show that it now works correctly.

The second method to preload a .int/.gnt is to use the Micro Focus Entry Point Mapper or MFENTMAP. This is
more complicated to configure than simply using a procedure-pointer but we will include it here for the sake
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of completeness.

First, comment out the set statement in our current program by placing an asterisk in column 7 of its source
line as shown below so that the program?2.int will not be preloaded.

identificaticn divisicn.
program-id. Programl.

environment divisicn.
configuration section.

data diwvision.

working-storage section.

@1 myparams pic x(28) walue "from progl"”.
@1 pp procedure-pointer.

procedure division.

| set pp te entry “"program2”
call "prog2” using myparams
goback.

end program Programl.

Open up Notepad or any text editor and create a file containing the following three lines:

[ENTRY-POINT] prog2
[PROGRAM-NAME] *
[SUBPROGRAM-NAME] program2

Save this file in your intgntmain project folder using the name “mfentmap.dat”.

If using Notepad, ensure you change the file type to All Files so that it will not add the extension .txt to the file.

So the file will be called C:\intgntmain\intgntmain\mfentmap.dat.
T

~
| Save As - =5
@U" « intgntmain » intgntmain » v ’ 4 ‘ l Search intgnimain o]
Organize v New folder 4= - @
“# Dropbox = Name Date modified Type
£ Recent Places . gt 2 .
bin 9/5/2012 9:52 AM File folder
e obj 9/5/2012 9:52 AM File folder
4 Libraries 3 2 kD
- | Properties 9/5/2012 9:52 AM File folder
|-¢| Documents X 2 ; ; &
J' Mus @ intgntmain.cblproj 9/5/2 COBOL Proj
1 Music =
(9 [ =)) intgntmain.cblproj.user 9/5 V Visual Studi
b=/ Pictures : - sl
i || intgntmain.dep 9/5/201210:53 AM  DEP File
E# videos 3] - X R A
intgntmain.sin 9/5/20129:52 AM  Microsoft V
*, intgntmain.suo 9/5/201211:10 AM  Visual Studi
18 Computer R = %
B = || Programl.cbl 9/5/201211:10 AM  CBLFile
&, Local Disk (C) N R
3 7] Program2.cbl 9/5/201210:14 AM  CBL File
#2 DVD RW Drive (D: :
- 4 | L 3
I File name: mfentmap.daﬂ v
' Save as type: | All Files (*.%) '] i
4 Hide Folders Encoding: [ANSI V} l Save l l Cancel l
LN
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When using MFENTMAP you would create the three entries shown in the file for each of the entry points that
you would like to make known to the run-time system.

[ENTRY-POINT] prog2 - This is the name of the entry point used in the call statement.
[PROGRAM-NAME] * - This is the name of the calling program. Use * to mean any program.
[SUBPROGRAM-NAME] program2 - This is the name of the program that contains the entry point.

In our case when calling “prog2” the run-time system will first load “program2” if required in order to find
“prog2”.

To complete the setup we must set a couple of environment variables.

Right click on the project name intgntmain in Solution Explorer and select Add—>New Item as shown below:

B le Subtitle = Lhal
'§| = _:||:IJJ.JJJ__}®$'.-’3;EQJ_.J_¢ _;:JJﬂj|Changr:T,pr:' I (e Styls
Programl.chl [Code]* Solution Explorer ~ 1 x
vl W procedure division =) | e
identification division. ; Solution ' |r1tgr1tma|r1 (1 project)
program-id. Programl. E intgn

. . . =l Rebuild
configuration section. @ i
Clean

EX
¥
=) F Build
environment division.
[P

data division.

= i Add 3
working-storage section. il blexien ElitsShifth .
@1 myparams pic x(2@) value "from progl”. | [ Existing ltem... Shift+Alt+A Add Service Reference...
el pp procedure-pointer. Dl | New Folder Add Existing COBOL Items...

procedure division.

O Set as StartUp Project
'—'g Seluti...
set pp to entry "program2” Debua 3

Select Application Configuration file from the list and accept the default name of Application.config by clicking
on Add.

rAdd New Item - intgntmain ', ! : ‘ T : M

Installed Templates Sort by: |Defau|t Search Installed Templates P ’
4 COBOL Items —
Y Type: COBOLIt
[Native] r| COBOL Program COBOL ltems e e

A file used to configure Application

= settings
D Copybook COBOL Items

Application Configuration... COBOL Items

Online Templates

= 2] ResourceFile COBOL Items

Application.config

The file will be added to the intgntmain project. Right click on Application.config in Solution Explorer and
select Edit.
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Solution Explorer v ax

=B

m Programl.cbl [Code]® X

-] ¥ procedure division

identification division. % ; Solution ‘intgntmain’ (1 project) &
program-id. Programl. o K &1 intgntmain
. L =d| Properties
env:u:onmen? d1v151c'>n. B Referenices
configuration section. =3 A;i;iiré*iﬂ;‘ R
E S
| = LT
data division. !?\] Pr¢[1 Open
working-storage section. 15 Pre Open With..,
81 myparams pic x(20) value "from progl”. |4 Edit
81 pp procedure-pointer.
precedure division. Exclude From Project
set pp to entry "program2" % Cut Lhix
call "prog2" using myparams 53 Copy Ctrl+C
goback. X Delete Del
end program Programl. B | lj ‘ Rename
» CoreTo 0l 125 Properties Alt+Enter

In the popup editor that appears add the new environment variable ENTRYNAMEMAP with the value of the
mfentmap.dat file that we saved previously. Press Set and then OK to Save it.

ol Application Settings

Environment | COBOL Switches |

Variable Value
ENTRYNAMEMAP c:\intgntmain\intgntm. ..

Name ENTRYNAMEMAP

Value c:hintgntmaintintgntmainmfentmap dat

| set || Delete |

We must also create a cobconfig.cfg file containing the RTS tunable entry_point_mapper=TRUE in order to
turn on the support for MFENTMAP.

Open up Notepad or any text editor and create a file containing the following line:

set entry_point_mapper=TRUE
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Save this file in your intgntmain project folder (same location as mfentmap.dat) using the name
“cobconfig.cfg”. If using Notepad, ensure you change the file type to All Files so that it will not add the
extension .txt to the file. So the file will be called C:\intgntmain\intgntmain\cobconfig.cfg.

| Save A
| Save As ——
OU : ‘ « intgntmain » intgntmain » v | 45 l | Search intgntmain pel |
Organize v New folder SES 2 @
“# Dropbox o Name . Date modified Type
% Recent Places . SR _
bin 9/5/2012 9:52 AM File folde
o F | obj 9/5/20129:52 AM  File folde
4 Libraries 3 :
= | Properties 9/5/2012 9:52 AM File folde
|¢] Documents - ghtes ’ D i 2 |
J“ Mo || Application.cenfig 9/5/201211:31 AM  CONFIG |=
usic = - . - -
{3 ] intgntmain.cblproj 9/5/201211:32 AM  COBOLF
|&=| Pictures -\ . : 2 L
5o intgntmain.cblproj.user 9/5/201210:53 AM  Visual St
|| intgntmain.dep 9/5/201211:32 AM  DEP File
~ [ intgntmain.sln 9/5/20129:52 AM  Microsof—
/% Computer s ) R LA A
: intgntmain.suo 9/5/201211:10 AM  Visual St
&, Local Disk (C:) T - )
= 3 | 7| mfentmap.dat 9/5/201211:19 AM  DAT File +
#3 DVD RW Drive (D:
w-| 40l 1 | »
File name: cobcenfig.cfg 5
Save as type: | All Files (*.*) v]
4 Hide Folders Encoding: [ANSI v] [ Save ] [ Cancel ]

L\

We must now set the environment variable COBCONFIG to point to the location of the file we just created.
This environment variable must be set in the computers environment as it cannot be set within the
application.config file.

Open up Control Panel>System—>Advanced->Environment Variables and select New under System
Environment Variables. The location of this option is system dependant but under Windows 7 it can be found

L
~
>
-
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Enter COBCONFIG as the variable name with a value of c:\nativemain\nativemain\cobconfig.cfg then press OK
to save it.

In order for Visual Studio to pick up the new value it must be restarted.

Click the Save All icon from the IDE menu and then close Visual Studio by clicking the X in the upper right hand

corner.
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—rting ot @ Frogesl ol
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. edure gulote
‘
g o
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Start Visual Studio again and select our project intgntmain from the list of recent projects to reopen our
solution. You can also use the File>Open—>Recent Projects and Solutions option.

Vs - &L 3 .3
(od » e ==
fessonal
& enn e
oeTe | e .
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2 ‘ b Cavems—por sptessryse A0

Start debugging by pressing F11 and step through the call statement. “prog2” will now be found via
mfentmap.dat.

This works fine in this example because both the calling program and the called program both exist in the
same project. We will now place the two programs in separate projects to demonstrate a common scenario.
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First delete the current Program? files from the intgntmain output folder by using Windows Explorer to
navigate to c:\intgntmain\intgntmain\bin\x86\debug, selecting the two Program2 files as shown, right clicking
and selecting Delete.

= lotgetman v wtgreman ¢ b » 8 » Deug
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Then right click on the Solution name in the Solution Explorer window and then Select Add->New Project as
shown below. Make sure that you right click on the Solution name which will be at the top and not the Project
name which will be under it.
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Select Native under COBOL and then Micro Focus INT/GNT Project as the project type. Change the name of
the project to program2 and leave the Location set to c:\intgntmain so that the new project will be in a
subfolder of the main solution. Press Add to add the new project to the solution as shown below:

s — R
244 New Proget P . " | — - ‘ —
| NET Framework & ~ | Sort by | Defautt 1 o earch vd Terrplate £
lentalied Tomplates
i —_— ) s Type: COEOL
- 81 Window Appication Coedt
< COS0L A project for creeting Micro Focus INT or
Databiese GNT code
Managed q Conscln Applicstion CoedL
[Hotivr] e
Web |co | Empty Project COedL
Vel Basic ——
Visual C# 2L Link Library COedl
Vsl Ce e
Vil Fo & Micro Foous INT/GNT COBL
Database
Test Progects Micro Focus INT/GN

Other Progect Types

Hame: program2

Location: cluntgnmain v | Browse.,

i

The new project program2 will be created in the solution.

Now move the program2.cbl source from project intgntmain to project program2 by dragging it from
intgntmain to the project name program2 (with CBL project icon next to it) You could also do this by right
clicking on Program2.cbl in intgntmain and selecting Cut and then right clicking on project name program2 and
selecting Paste. Your solution should then look like the following:

'I % procedure division - | =
identification diwvision. =z ; Solution ‘intgntmain’ (2 projects)
arogram-id. Programl. " 4 @ intgntmain
=d| Properties
znvironment divisicn. ] References
coenfiguration section. Application.config
—_
data divisicn. [ Programl.cbl
working-storage section. =l + ] program2
31 myparams pic x(28) walue "from progl”. =d| Properties
31 pp procedure-pointer. -a] References
srocedure division. [@ Program2.chl

set pp to entry "program2”
call "prog2" using myparams Il"a Soluti...

Now Press F11 to rebuild the solution and start debugging again.

This time you will once again receive the RTS 173 error even though we are still setup to use MFENTMAP
Click on the Break button and then select Stop Debugging from the Debug menu item (or press Shift-F5).

So what has changed?

The difference is that program2 is now in a different project which has a different output folder than the
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calling project.

Programl.int is in C:\intgntmain\intgntmain\bin\x86\Debug
and

Program2.int is in C:\intgntmain\program2\bin\x86\Debug

When the application is started the folder containing the startup program becomes the current folder so any
programs that it calls, such as program2.int must either also be in the startup folder or they must be in a
folder which is referenced in the COBPATH environment variable. In our previous tutorial using native .DLL
files we used PATH to locate the files. COBPATH is used instead when locating .int or .gnt files.

Let’s try the following.
Double-click on the application.config file under the intgntmain project in Solution Explorer to open up its
popup editor.

In the popup editor that appears add the value COBPATH in the name field and enter the location where the
program2.int resides in the VALUE field and press SET. Then Press OK to save this.
-

ul Application Settings X

Environment | COBOL Swiches |

Variable Value
ENTRYNAMEMAP c:\intgntmain\intgntm...

Name COBPATH

Value c:hintgntmain‘program2\bin‘x86\debug

[ set ][ Deere |

Press F11 to start debugging again and when you execute the call “program2” statement it will now work.

If you have a large number of INT/GNT projects in your solution it may become a hassle to have to set the
COBPATH to include the output folders of every project. In this case it may be advantageous to change the
output folders of all projects to point to a common location such as the output folder of the main application
or a new common folder. You must remember that when doing so you must change the output folder for each
build type as these specify different locations.

Let’s give this a try. First right click on the application.config file under Solution Explorer and select Edit.
Highlight the entry for COBPATH and click the Delete button. Then click OK to save it. Leave the
ENTRYNAMEMAP entry alone for now.
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-
ul Application Settings @

Environment | COBOL Switches |

Variable Value
ENTRYNAMEMAP c:\intgntmain\intgntm...
COBPATH c\intgntmain\progra...

Name COBPATH

Value c:hintgntmain‘program2\bin'x86'\debug

[ set || Delee

[ ok ][ Cancel |

In Solution Explorer double-click on Properties under the intgntmain project heading to display the Properties
page below. Click on the COBOL tab to the left and scroll down until you see the entry for Output Path: Change
the current value to ..\compiledprogs\bin\x86\debug. This will place the project output into folder
c:\intgntmain\compiledprogs\bin\x86\debug. It is best to use the relative paths like “..\” instead of
hardcoding the names in case the solution is moved to another folder.

Click on the save icon to save the changes.

1513 d 2|} =l &l =) = | Change Type~

o2 2] | Sl Spatial Indexes... |}

! i%’||:§|ﬂ@:§ ..=.I| '5

[T Program?.cbl [Code] Programl.cbl [Code] » Solution Explorer

=Y

Application ; Solution 'intgntmain’ (2 projects
Lonfiguration: [Active (Debug) '] 4 CEBE intgntmain
sqL =d| Properties
Platform: | Active (x86) ~| = ree
Copvbook Path gl References
DPpYDOOK - 7| Application.config
— Errors and warnings - [8] Programi.chl
Warning level: [Includewamings (Level W) VI 4 (] program2
COBOL Link =d| Properties
Stop after: 100 [C] Treat warnings as errc «a] References
Debug [m] Program2.chl
Output
Output path: .\compiledprogs\bin'u@6\debug 7 I Team...
[7] Generate directives file [] Generate listing file | Properties

Additional directives
2= [N

Close the intgntain property page and open up the property page for the program2 project and make the
same changes that you made to intgntmain using the same Output Folder name of
..\compiledprogs\bin\x86\debug.

Save this and start debugging again by pressing F11 and “program2.int” will be loaded by the run-time
without the need for the COBPATH to be set because “program2.int” now resides in the same folder as the
startup program Programl.int.

E2 Class.
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Delete the application.config file from the project by right clicking on its name in Solution Explorer and
selecting Delete. Then uncomment the set statement in program1.cbl so it once again will set the procedure-
pointer and load “program?2.int”. Debug again by pressing F11 and “prog2” will now be found without the
need to set either COBPATH or ENTRYNAMEMAP.

If you wished to create .gnt files instead of .int files for this tutorial you can check the create .gnt option under
the COBOL tab of the project properties page for both projects. Everything else will be the same.

liiliiaETe s Program2.chl [Code] Programl.chl [Code]
Application
Configuration: [Active {Debug) v]
SQL
Platform: | Active (86) - |
Copybook Paths
COBOL General -
Platform target:
COBOL Link 1
COROL dialect: ’Non—mainframe v] =
Debug -
Source format: ’FIXEd "']
Compile for debugging Compile to .gnt

Remove the COBCONFIG environment variable from the computers environment by opening up Control
Panel->System—>Advanced-> Environment Variables, selecting COBCONFIG in the list and clicking Delete.
Close Control Panel and Close Visual Studio.
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1) Summary

We have covered a number of different scenarios here in the preceding tutorials, some of which may or may
not be applicable to your particular application.

The chart below summarizes the techniques that we covered in these pages and outlines under which
scenarios each can be used.
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